
CONTENTS
About This Course 
Overview of Course 
Training Materials 
Session Checklist

Key Points of  
Training Course and 
Discussion Topics

Training Points and 
PowerPoint® Overview

Customizing a 
PowerPoint ® Presentation

Tips for the Instructor 
Presentation Tips
Question and Answer Techniques
Evaluation Methods

Course Evaluation

Quiz

Answer Key

Certificate of Completion

LEADER’S GUIDE

1

1

www.dsslearning.com

   DETECT
AND DEFEND

Pre
vie

w O
nl

y



2

2

Copyright © Coastal Training Technologies Corp.

Hydrogen Sulfide: Detect and Defend

www.dsslearning.com

www.dsslearning.com

ABOUT THIS COURSE
Hydrogen sulfide is a leading cause of inhalation-related deaths in the workplace. It’s toxic, 
flammable, and can even be explosive. It often cannot be detected with your senses alone. 
If you’re at risk of exposure and don’t know how to protect yourself, hydrogen sulfide can 
be a dangerous killer. In this course, Hydrogen Sulfide: Detect and Defend, we’ll identify 
the dangers of hydrogen sulfide and show you how to defend yourself against the hazards of 
exposure. We’ll describe how hydrogen sulfide is produced, its chemical properties and how 
to respond to its health and safety hazards. We’ll identify various hazard prevention strategies 
and finally, show how to avoid exposure by using personal protective equipment.

The program is 15 minutes long and can be viewed straight through by selecting “Play Program” 
from the DVD main menu. To view the program in chapters, which permits discussion during 
viewing, select “Program Outline.”
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Training Materials
There are a few things you’ll need for an effective training session:

 • A training room located away from major distractions or interruptions
 • A comfortable arrangement of chairs and tables, preferably in a circular pattern, with an 

opening for a TV monitor and other visual aids. (Be certain all participants can see the 
TV monitor and other visual aids.)

 • Adequate lighting that can be adjusted while viewing the program
 • A location, possibly including a podium and/or a flip chart, from which the  

trainer/speaker can lead discussion 
 • The training program Hydrogen Sulfide: Detect and Defend
 • TV or DVD player/computer with projector and remote
 • Copies of the daily schedule 
 • A copy of the handbook, paper and pencil for each participant
 • A flip chart or dry-erase board and appropriate markers
 • A computer with PowerPoint® software and the PowerPoint® Presentation
 • Copies of the Quiz and the Course Evaluation, both printable from the DVD.
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Session Checklist
Preparation Activities a few days before session begins:

 ☐ Ensure room is reserved.
 ☐ Identify location and quantity of all required materials.
 ☐ Obtain class roster; ensure student notifications and administrative issues are handled.
 ☐ Make name tags or table tents for students’ name or provide blank ones and markers.
 ☐ Obtain parking passes for participants, if appropriate.
 ☐ Print the sign-in sheet.
 ☐ Verify that audio-visual equipment operates properly.
 ☐ Check your instructor materials and notes.
 ☐ Reproduce any additional handouts, e.g., daily schedule, evaluation forms.
 ☐ Rehearse your presentation. Practice using the instructional aids and conducting any   

 demonstrations. Make notes and write down any additional points you plan to discuss.

Preparation the day of training:

 ☐ Set up the classroom; arranging tables, chairs for your intended purpose.
 ☐ Check audio-visual equipment.
 ☐ Distribute class supplies (paper, pens, workbooks, etc.).
 ☐ Consider refreshments.
 ☐ Make sure the classroom environment is pleasant and comfortable (temperature,  

 lighting, etc.).
 ☐ Write your name on the board.

Opening the Session

 ☐ Greet the students at the door; establish relationships, set the tone.
 ☐ Welcome formally; establish positive atmosphere.
 ☐ Explain agenda and objectives for the session.
 ☐ Discuss participant materials.
 ☐ Use an ice breaker to motivate audience.
 ☐ Provide “big picture” of the training session.

After session action:

 ☐ Clean up the classroom.
 ☐ Thank those who supported your session.
 ☐ Summarize student evaluation forms.
 ☐ Send out any promised information.
 ☐ Review your instructor notes and write down any observations of what you would change  

 or do differently the next time.
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KEY POINTS OF TRAINING COURSE  
AND DISCUSSION TOPICS
Introduction
Overview and Objectives
Change attitudes by increasing workers’ safety awareness of hydrogen sulfide (H2S), 
specifically on the topics of production and properties, health and safety hazards, and hazard 
prevention strategies.

Production 
Production of Hydrogen Sulfide
Objective: Describe how hydrogen sulfide is produced.

Key Points
 • Hydrogen sulfide is a toxic, colorless gas that is produced naturally as well as industrially 
 • Identify how hydrogen sulfide is produced, both in nature and industrially 
 • Identify areas that pose a significant risk for exposure.

Discussion Topic
 • Identify areas and examples of where and how you could be exposed to hydrogen sulfide, 

both at work and off the job.

Properties and Labeling
Physical and Chemical Properties
Objective: Describe physical and chemical properties of hydrogen sulfide.

Key Points
 • Identify the Globally Harmonized System (GHS) classification and labeling for hydrogen 

sulfide 
 » Give examples of GHS label components

 • Product identifier
 • Signal word
 • Hazard statement
 • Precautionary statement
 • Pictograms
 • Name, address, and telephone number of the manufacturer, importer or other 
responsible party.

Discussion Topic
 • Locate an example of a Safety Data Sheet (SDS) or Hazard Communication label for 

hydrogen sulfide in your facility or work area, and share it with the group. Discuss each 
part of the label and the importance of the information provided. 
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Health and Safety Hazards
Health Hazards and First Aid
Objective: Describe the health hazards and first aid.

Key Points 
 • Inhalation exposure

 » Symptoms – Irritated nose, throat and lungs; headaches; dizziness; breathing 
difficulty, coughing; nausea; coma and even death

 » Treatment – Leave area immediately, get to fresh air and seek medical attention
 • Eye exposure

 » Symptoms – Burning, discomfort, watering and redness
 » Treatment – Flush eyes continuously for at least 15 minutes, seek medical attention

 • Skin exposure
 » Symptoms – Irritated eyes; burning, discomfort, frostbite or redness of skin
 » Treatment – Remove clothing, wash skin, and seek medical attention

 • Locate safety showers and eyewash stations and test these regularly
 • Know your company’s emergency procedures.

Discussion Topic
 • Review your company’s emergency procedures. Ask participants if they know what to do 

in the event of hydrogen sulfide exposure.

Hazard Prevention Strategies
Safe Work Permits
Objective: Describe the safe work permits, practices, and air monitoring.

Key Points
 • Safe work permits are implemented as hazard prevention techniques to prevent H2S 

release or exposure
 •  Examples of where safe work permits are needed:

 » Confined spaces 
 » Lockout/tagout 
 » Welding and hot work 
 » Excavation and trenching 

 • Precautionary measures like lockout/tagout and air monitoring must be practiced as part 
of the safe work permit.

Discussion Topics
 • What safe work permits are needed for the jobs/tasks performed at your facility? 
 • Discuss how workers obtain safety training and safe work permits for their jobs.
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General Safe Work Practices
Objective: Identify examples of safe work permits that help prevent hydrogen sulfide 

exposures.

Key Points
 • Never work alone – use a buddy system
 • Good communication is important
 • Note which way the wind is blowing so you know the safest escape route
 • Check for ignition sources and personnel in downwind areas
 • Ensure air monitoring and ventilation system are working properly
 • Stay alert and aware of potential hazards.

Discussion Topic
 • Ask participants to share safe work practices they use to ensure they and their co-workers 

remain safe when H2S is present.

Air Monitoring 
Objective: List requirements for air monitoring.

Key Points
 • Never rely on your sense of smell – make sure air is tested by a qualified person 

 » Test equipment may include detector tubes or multi-gas meters
 • Fixed gas monitors 

 » Can be located where the possibility of widespread contamination exists
 • Portable gas monitors 

 » Allow you to check the atmosphere in any location
 • Never rely solely on your gas monitor

 » If you suspect H2S is present, evacuate immediately and move to a safe location.
Discussion Topic

 • Discuss the types of gas monitors you use. Point out locations of any fixed gas monitors 
throughout the facility, and go over how to use a portable gas monitor.
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Personal Protective Equipment (PPE)
PPE Controls
Objective: Describe Personal Protective Equipment (PPE) hazard controls.

Key Points
 • Respiratory protection – protects you against three types of exposures

 » Lower concentrations – below 100 parts per million or ppm
 • Use an air purifying respirator with a cartridge

 » High concentrations – at or above 100 parts per million or ppm – or unknown 
concentrations 
 • Use a full-face, pressure-demand, self-contained breathing apparatus (SCBA) – a 
minimum service life of 30 minutes or 

 • Use a combination of full-face piece, pressure-demand, supplied-air respirator with 
auxiliary self-contained air supply

 » Emergency escape 
 • If there is a risk of gas leak emergency, carry an escape SCBA with you

 • Eye and face protection 
 » Use safety goggles or face shield combined with safety glasses

 • Skin protection 
 » Wear protective gloves, coveralls, boots and full-face protection

 • Personal hygiene 
 » Remove exposed clothing and dispose of it according to your employer’s guidelines 
 » Never eat, drink or smoke while working around toxic chemicals 
 » When you leave the site, wash your hands before eating, drinking, smoking or 

applying cosmetics.
Discussion Topic

 • Identify what types of PPE are needed in your facility. Ensure the participants are 
familiar with the PPE needed for their jobs, and how to use them properly.

Summary
Now that you know the importance of following all the safety guidelines for working around 
hydrogen sulfide, it’s up to you to follow them. Safety is about being constantly aware of what’s 
going on around you and staying focused on every detail of the job you’ve been trained to 
perform. By following the right procedures and staying aware, you can keep your workplace 
productive and safe.Pre
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CUSTOMIZING A POWERPOINT® PRESENTATION
The PowerPoint® presentations included on the DVD products are customizable when used on a 
computer loaded with Microsoft PowerPoint® software. (Note: In the following instructions, “click” 
implies a click with your left mouse button. If a “right” click is necessary, it will be so indicated.) 
Microsoft PowerPoint® has many features. The following steps will help you customize  
our presentations quickly.

To customize a presentation:
If the “Customizable Version” icon is displayed on the landing screen, click on this option. If this 
option is not available, click on the PowerPoint® presentation to open it.

Save this presentation to another location, such as your hard drive or a folder on the network.  
You will make your customizations on the saved version.

To add, copy, hide or remove a slide, or to change the order of the slides in    
the presentation:
Click on “View” on the menu bar.

Click on “Slide Sorter” from the “View” menu. Or, under the “Normal” view, you may use the 
“Outline” on the left side of the screen.

To add a slide, place your cursor in front of the slide where you want to add a slide. Click on “Insert” 
on the menu bar. Then, click on “New Slide” on the “Insert” menu. Or, click on the “New Slide” tool 
on the tool bar. Choose a slide format to fit your desired content, and follow the prompts given.

Sometimes it’s easier to copy a slide, and then change the content of the slide, than to create a 
new one. To copy a slide, click on the original slide. Click on “Edit” on the menu bar, and choose 
“Duplicate.” A new copy will be created to the right of the original slide. Or, click on “Edit” on your 
menu bar, and choose “Copy.” You may then “Paste” the slide wherever you want it to appear.

To hide a slide from your presentation, but to keep it for future use, right-click on the slide you wish 
to hide, and choose “Hide Slide” from the menu. Or, click on the “Hide Slide” tool on the tool bar. 

To remove a slide from the presentation, click on the slide you want to remove. Click on “Edit” on 
the menu bar. Then, click on “Delete Slide” on the “Edit” menu. Or, click on the slide, and press the 
“Delete” key on your keyboard.

To change the order of the slides in the presentation, click on the slide to be moved and while holding 
the mouse button depressed, drag the slide to its new location. Release your mouse button to place  
the slide.

If you wish to change or remove the animation effect as you move from slide to slide:
Double-click on the slide you want to change the animated transition on.

Double-click on the text box of the slide. A border and white handles appear around the text box. 

Click on “Slide Show” on the menu bar. Then, click on “Preset Animation.” To turn off the effect, 
choose “Off.” If you wish to change the effect, there are many options to consider.

To edit content of any slide:
Double-click on the slide you want to change.

Double-click on the text box of the slide. A border and white handles appear around the text. Type 
the desired changes.

Remember to save any changes made to your presentation!
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TIPS FOR THE INSTRUCTOR
Presentation Tips

Overcoming anxiety
The best way to overcome anxiety about speaking before a group is to be prepared. Although 
it’s natural to be nervous, your sweaty palms will disappear once you focus on what you are 
saying. Concentrate on what you want people to understand and your presentation will flow 
naturally.

Choosing your vocabulary
It’s best to use the same comfortable language that you would use when speaking one-on-one. 
Avoid jargon and overly complicated words or phrases.

Getting rid of the “umms”
One of the most annoying mistakes a speaker makes is saying “umm” every time there is a 
break between thoughts. Remain silent while you think about what you’re going to say next. 
The silence will seem longer to you than it will to the audience. If you remember this, you’ll 
feel less pressure to fill the silence. You can control your “umms” by jotting down notes 
beforehand. If you want to include personal anecdotes or examples, write down a few notes to 
trigger your memory. Beware of writing down too much, however. You’ll deliver your message 
to your note cards instead of your audience. 

Controlling the speed and tone of your voice
You’ll put your audience to sleep if you speak too slowly, and they won’t be able to keep 
up with the content if you speak too quickly. Approximately 150 words per minute is the 
best speed (that’s about two-thirds of a page, typed, double-spaced). Vary your tone often, 
especially when making an important point. Adding emotion to your presentation will keep 
your audience involved. Again, strive for a conversational tone.

Sticking to the schedule
Begin class on time and restart the session promptly at the end of the break. Except for 
emergencies, participants should not be interrupted for messages.
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Question and Answer Techniques
Asking questions is an instructional technique that can maximize the amount of interpersonal 
interaction in an educational/training session. Generally, the more learners participate and 
contribute to a discussion, the more they learn from the interaction.

Specific advantages to asking questions to a group of learners include:
 • The burden of learning is transferred to the learner. 
 • The learner becomes more involved in the learning process leading to a relevant and 

meaningful exchange of thoughts and ideas.
 • Both learner and instructor get useful feedback. They learn how effectively a concept has 

been communicated, whether any misunderstanding exists, and how to clarify certain 
confusions.

 • Questions help explore the content to new, more profound depths. 
 • Questions may reveal underlying attitudes and opinions of the trainees, as well as provide 

the instructor with insight into how best to help the trainee learn.

Types of Questions
 • Open-ended questions allow respondents to answer in any manner they want. These 

usually begin with words like what are, where did, why are, how can, tell me, and so forth.

 »  Reflective questions are used to seek confirmation that what you have heard is what 
was meant, and to encourage learners to clarify their interpretation. Examples are:  
“So, what you are saying is that, in your opinion…. Is this correct?” 
“If I heard you correctly, you said…. Is that right?”

 »  Hypothetical questions ask “what if?” They encourage the learner to guess what 
would happen in a given situation. An example is: 
“What would happen if…?”

 • Closed-ended questions limit the response to a specific answer, such as “yes” or “no.” 
They can be used to recall facts but are not conducive to discussion and interaction from 
the audience.

 »  Leading questions prompt the learner to agree with the questioner. It is a way of  
questioning that really states the viewpoint of the questioner. 
For example: 
“But you really wouldn’t do that, would you?”

Effective Questioning Strategies

1. Use leading questions as a means of introducing a new topic or making a transition  
 from one topic to another. 
2. Ask the question first and later direct it to an individual. This prompts all participants  
 to consider the question, before you call on someone to provide an answer.
3. Redirect questions whenever possible. You can maximize learner involvement by  
 asking others in the session to answer questions that another student has asked.
4. Be willing to admit if you do not know the answer. Honesty is the best policy; you will  
 lose credibility if you try to bluff your way to an answer. Once you acknowledge you  
 do not know the information, follow up with “I will find the answer!” and later share  
 what you find with all participants.
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Evaluation Methods
Following the practice of Donald Kirkpatrick’s Four Level Evaluation Model, two types of 
evaluation/assessment instruments are provided.

Level 1 – Reaction

Use a Course Evaluation form to assess how the learner felt about the training or learning 
experience. Print sufficient copies to distribute to all the learners and collect them after the 
class ends.

Level 2 – Learning

Use the 10-item multiple choice Quiz to measure the learner’s increase in knowledge about 
this subject matter. Print copies, distribute, and review the Quiz with the learner so that 
corrective feedback is provided and the learner recognizes what content he or she has 
mastered. An Answer Key follows the Quiz. 
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COURSE EVALUATION
Your input is IMPORTANT in helping us evaluate and improve our training programs. 
Thank you for taking time to think about and respond to the following questions.

Course:       Date:      Facilitator:     

About the Course

1.  Were the objectives of the course clearly stated? q YES qNO
2.  How well were the objectives met by the course?
    Were not met 1 2  3  4  5  Were met very well
3.  How applicable will this training be to your job?
    q  Almost none of the material will be applicable to my job.
     q  Some will be applicable, but some was confusing or irrelevant.
     q  Absolutely applicable! I look forward to seeing results soon!
4.  Was the information presented in a logical and understandable order?
    q  Didn’t seem logical at all.
     q  Some was, some wasn’t.
     q  Yes, all of it seemed logical and understandable.
5.  How useful were the discussions and the exercise(s) in helping you learn the information?

    q  Not useful at all q  Somewhat useful q  Very useful
6. To what extent did this training meet your expectations?

   qDid not meet qMet q Exceeded
7.  What would you add or change to improve this course?
                 
                 

About the Facilitator

8.  Was the facilitator positive and professional? qVery much so qCould improve
9.  How well was the facilitator prepared and able to explain the information? 
    NOT well prepared 1 2 3 4 5 VERY well prepared
10.  Did the facilitator create an atmosphere that encouraged questions and learning?

    q Yes qNo – Facilitator should have:        
11. Did the facilitator explain the material in ways that made it applicable to your job?

    qVery much so q Sometimes qAlmost none was connected to my job
12. Your comments on the facilitator:         
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QUIZ 
1. Hydrogen sulfide is: 

 A. A colorless gas

 B. Nontoxic

 C. Only produced industrially

 D. A milky white liquid

2. In nature, hydrogen sulfide is produced: 

 A. During mining operations

 B. During the petroleum refining process 

 C. By decaying organic matter

 D. By food processing

3. The statement “H2S is fatal if inhaled, very toxic to aquatic life. Extremely flammable.”  
Is an example of a:

 A. Signal word

 B. Pictogram

 C. Precautionary Statement

 D. Hazard Statement

4. The chemical formula for hydrogen sulfide is: 

 A. H2O

 B. HS2

 C. H2S

 D. None of the above

5. Which of the following is an example of a Signal Word that would be found on a 
hydrogen sulfide GHS label? 

 A. Danger 

 B. Preservation

 C. Nontoxic

 D. Gaseous
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6. Which of the following is a type of exposure you can get when working around  
hydrogen sulfide?  

 A. Inhalation exposure

 B. Ultra-violent exposure

 C. Audible exposure

 D. Aquatic exposure

7. Which type of safe work permit is least likely to involve hydrogen sulfide? 

 A. Lockout/tagout permit 

 B. Crane/lifting permit

 C. Confined space permit

 D. Excavation permit

8. Which of the following is a safe work practice you should follow to avoid exposure  
to hydrogen sulfide: 

 A. Never work alone

 B. Continually check and remain aware of potential hazards

 C. Make sure air monitoring and ventilation systems are working properly

 D. All of the above

9. Two common types of multi-gas meters are:

 A. Portable and transparent 

 B. Motionless and fixed

 C. Fixed and portable

 D. Transparent and fixed

10. What is your best defense against inhalation of hydrogen sulfide?

 A. Respirator

 B. Chemical safety goggles

 C. Coveralls

 D. Protective gloves

Pre
vie

w O
nl

y



19

19

Copyright © Coastal Training Technologies Corp.

Hydrogen Sulfide: Detect and Defend

www.dsslearning.com

www.dsslearning.com

ANSWER KEY 
1. A

2. C

3. D

4. C

5. A

6. A

7. B

8. D

9. C

10. A
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This Leader’s Guide is not intended as a substitute for first-hand knowledge of the applicable 
regulations. As a developer of high quality training materials, we emphasize the spirit  
and intent of OSHA regulations and other regulatory bodies.

This guide is designed to provide accurate and authoritative information regarding the 
subject matter covered. Sources for this information are believed to be reliable. Because of 
the possibility of human error, the publisher does not guarantee its accuracy, adequacy or 
completeness. We are not responsible for any errors, omissions, misprinting or ambiguities 
contained herein or for the results obtained from use of such information. If legal advice or 
other expert assistance is required, the services of a competent professional should be sought.

This Leader’s Guide is one of a series of print materials, video, online and DVD programs. 
Each product is the result of painstaking analysis, design, development and production by  
the instructional designers and technical specialists on our staff.

Our catalog is constantly being revised and expanded, so we would appreciate any  comments 
on current titles or suggestions for future ones. For further information on any product, or to 
receive a free catalog, call 800-767-7703 or send a FAX to 757-498-3657. Visit us on the Web  
at www.dsslearning.com. 

This guide is for educational purposes only. Nothing herein is to be regarded as indicating 
approval or disapproval of any specific practice or product.

Copyright © 2014 Coastal Training Technologies Corp. Purchasers and renters may copy  
the Quiz found in the Leader’s Guide when it is used in conjunction with the program.  
Any other part of this product may not be copied by any means or for any reason without  
the written permission of Coastal Training Technologies Corporation. All Rights Reserved. 
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